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1.0 – Software Introduction 

AVE Line Array User Control software is a sophisticated program that uses a complex proprietary 

algorithm to accurately calculate SPL distribution of AVE Ascolto
®
 Line Arrays. 

AVE Line Array User Control software has been developed for use with all Ascolto
®
 Line Arrays.  

AVE Line Array User Control software allows to simulate the environment to sound reinforce, select the 

appropriate dispersion pattern, introduce the proper acoustic equalization for the typology of audience and 

transfer all the aiming and filtering parameters through the dedicated network. 

Key Features 

Easy Setup: line array types, audience area geometry, beam design mode, appropriate audio equalization 

and audio classic controls can all be set from AVE Line Array User Control software. 

Intuitive User Interface: AVE Line Array User Control software uses both familiar “point and click” and “click 

and drag” commands and intuitive screens to display setup information. 

Project Backup and Restore: project configurations are stored to the hard drive for record retention. These 

file are especially convenient to restore line array settings or to copy configurations. 

Configuration Recall: global settings can be retrieved directly from the line array unit for proof checking or 

for maintenance uses. 
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2.0 – Getting Started 

2.1 – Workspace 

AVE Line Array User Control is used to design appropriate beam shape making the AVE Digital Line Array 

optimally aimed towards audience and achieving a maximum direct to ambient sound ratio, for best 

intelligibility. 

When user starts up AVE Line Array User Control for the first time, it will create and be shown an empty 

workspace. In order to start controlling, user will have to create a new project.  

Following sections provide a description of beam design modalities, audio controls and project 

managements.  

 

Figure: Empty Workspace. 

2.2 – COM Setup 

The PC running AVE Line Array User Control software should be connected to the line array unit using the 

USB to RS485 Serial Converter and cables supplied with the AVE Line Array User Control Configuration Kit. 

See the Driver Installation Section below for specific information. 

 

Figure: Selecting COM port. 

COM 
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Before to start, user has to select the serial port COM from the COM menu item in SETUP menu, which will 

be used by USB-RS485 serial converter to communicate with the AVE Line Array device. 

 

Figure: COM Setup. 

The proper COM port number associated to the USB-RS485 Serial Converter can be retrieved in Windows, 

opening Device Manager (see SETUP menu paragraph) and checking Ports (COM & LPT) or user can 

disconnect your USB-RS485 converter and re-open the menu SETUP→COM menu; the entry that 

disappears should be USB-RS485 converter. Reconnect the board and select that serial port. 

2.2.1 - Driver Installation 

Follow the steps below to install driver of USB-RS485 Serial Converter: 

1. Power on your computer and make sure that the USB port is enabled and working properly. 

2. Plug in the USB-High Speed Serial Converter into the USB port, the PC should then detect the new 

hardware, or if not, then run the Add New Hardware Wizard to assist you in setting up the new device. 

3. If the PC detect the new hardware it ask you to insert the USB – RS485 Serial Converter software driver 

(FTDI USB driver) into the CD-ROM drive and click next to continue. 

4. Windows will now detect the driver. Click Next to continue installation. 

Normally Windows is able to install device drivers automatically and you'll be notified that the device is ready 

to use. Otherwise, unzip file USB-RS485_serial converter_win_driver.zip included in the installation package 

and indicate to Windows such a folder containing the driver for the device when it will prompt you. 

Alternatively latest USB-RS485 drivers can be retrieved at following link: 

http://www.ftdichip.com/Drivers/VCP.htm 

  

COM Port Number COM Port Speed 

(fixed) 

http://www.ftdichip.com/Drivers/VCP.htm
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2.3 - Create a New Project 

To create a new Project in AVE Line Array User Control, follow these steps: 

 

Figure: Creating new project. 

1. Click the New Project on the File menu, or press CTRL+N. The New Project dialog box appears. 

 

2. In the New Project dialog box select the proper line array series from leftmost column, and then 

choose the line array model in middle column which matches the used device.  

The rightmost column shows main features of the selected line array of loudspeakers. 

 

3. Name the project, select his location, and then click OK. By default, the AVE Line Array User 

Control application saves a project named untitled.prj in the default working folder. 

 

 

Figure: New Project dialog box. 

This will create a "blank” project with default parameters for selected line array unit. The first tab control is 

the Beam Design tab control when the project first loads. The second tab is Audio Control (see next 

chapter). You are now ready to start entering your beam configuration and audio settings.  

Project Name 

Project Location 

Line Array Series 

Line Array Models 

Line Array Information 

New Project 
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3.0 – Beam Design 

3.1 – Beam Design Panel 

Beam Design tab content is composed by three expandable panels: 

 SPL Field panel. 

 SPL Field along Listening Level panel. 

 Beam Parameters panel. 

 

 

Figure: Beam Design Panel. 

 

  

SPL Field Panel 

SPL Field Pane along Listening Level Panel 

Beam Parameters Panel 
Status Bar 

Beam Design Tab 

Control 

Menu Control 

Audio Control Tab 

Control 
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3.2 – SPL Field 

SPL Field prediction panel depicts the averaged SPL field at selectable frequencies over an on-axis, vertical 

cross-section. 

SPL field is computed analyzing sound propagation in direct field condition, defined as the sound field which 

has not suffered any reflection from any room surfaces or obstacles. 

The SPL prediction technique uses a high-resolution method which employs a 1/12
th
 octave complex 

frequency resolution (magnitude and phase) and 1-degree angular resolution dataset to predict the direct-

field sound pressure level field. 

 

Figure: SPL Field. 

3.3. – SPL Field along Listening Level 

SPL Field along Listening Level panel shows average SPL along audience listening level Ha over distance. 

Such curve aids user in optimizing design process to estimate ripple in SPL field at various frequencies with 

different averaging bandwidths. 

Left ordinates indicate absolute SPL values in dB scale whereas, on the right plot side, relative SPLs are 

referred to the maximum value along the listening level.  

 

Figure: SPL Field along Listening Level. 

 

Absolute SPL values Relative SPL values 

Audio Beam 

SPL Color Bar  

Line Array 

Listening Level 
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Sound pressure estimating is conducted assuming an electrical output power for each channel equal to 1 

WRMS at selected frequency as chosen in SPL plot in Beam Parameters panel.  

3.4 – Beam Parameters 

In Beam Parameters panel, user can define dimensions of the listening area referring on a section through 

the space and choose the beam design mode for proper beam configuration. 

Such panel is composed by two tabs: 

 Beam #1 Parameters. 

 SPL Plot. 

 

 

Figure: Beam Parameters – Beam #1. 

Two beam design approaches are selectable in Beam #1 Parameters tab panel by means of the Settings 

Mode drop box:  

 Angles Mode 

 Distances Mode 

The SPL Plot tab of Beam Parameters panel allows user in selecting beam frequency at which SPL is 

predicted as well as the averaging bandwidth, expressed in fractional octave over that SPL values are 

averaged. 

 

Figure: Beam Parameters – SPL Plot. 

In addition, user can read the SPL value on single point over depicted area and clear all SPL tags previously 

inserted through the Clear SPL Tags button.  
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3.4.1 - Angles Setting Mode  

This setting mode allows user to control in an arbitrary manner the beam tilting angle, either positive or 

negative as well as the beam broadening angle. Studied for experienced users, it allows having the full 

control of the main beam lobe features. 

 

Figure: Audience area panel in Angles Setting Mode. 

Input parameters are defined as: 

 Anti Reverberation System. 

 Column Height. 

 Tilting Angle. 

 Broadening Angle. 

 Listening Level. 

 Air Attenuation Compensation. 

Select Anti Reverberation System checkbox in Beam #1 Parameters panel to activate anti reverberation 

feature.  Ascolto Line Arrays possess the innovative ARS
®
, capable of increasing the voice intelligibility in 

reverberant environments. 

 

Figure: Anti Reverberation System. 

The ARS conveys uniformly acoustic energy on the lower part of the audio beam and reduce drastically the 

audio emission upwards, attenuating significantly the acoustic reflections related to ceilings.  

 

 

 
ARS

®
 off 

 

 

 

 

 

ARS
®
 on 
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ARS
®
 off 

 

ARS
®
 on 

 

 

Figures: Anti Reverberation System ARS
®
. 

ARS usage is specifically studied and convenient in large reverberant environments, such as churches with 

long aisles, cathedrals or basilicas with high reverberation times RT60 (greater than 8 – 9 s). Conversely, for 

maximal line array throw, consider disabling ARS function.    

The Column Height is assumed as the height in meters between below floor and line array bottom side. 

Tilting Angle and Broadening Angle define respectively aiming and size of audio beam expressed in 

degrees. 

Start and end side dashed segments in SPL field plot define graphically the computed beam broadness 

angle assumed as SPL variation does not exceed more than 3 dB. Beam bisector indicates the computed 

tilting angle. 

 

Figure: SPL Field in angle mode. 

  

Figures: SPL Field examples for different tilting angles. 

Computed Beam Parameters 

Beam Broadness inside 3 dB 

Beam Bisector Listening Level 

Reduced SPL Ripple along Listening Level  
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Figures: SPL Field examples for different broadening angles. 

Listening Level indicates the average height of the audience plane and it would be a point midway between 

the sitting and the standing position (normally 1.2 m – 1.3 m). 

 

Figure: Listening Level. 

With Air Attenuation Compensation enabling check box, users may specify a frequency response 

correction in SPL analysis, based on a given relative humidity and temperature.  

Air absorption is sensitive to air temperature, air composition, particularly humidity concentration, and sound 

frequency.  

It is particularly necessary to account for air absorption in large spaces. 

 

Figure: Air Attenuation Compensation. 
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3.4.2 - Distances Setting Mode 

Used generally to optimize sound pressure level SPL within 3 dB inside a desired distance range, this setting 

mode is typically adopted for flat audience areas. It makes straightforward to quickly set-up and robustly your 

line array unit. 

 

Figure: SPL Field in distances mode. 

 

Figure: Audience area panel in Distances Setting Mode. 

Input parameters to manage beam setup are listed below: 

 Anti Reverberation System 

 Column Height 

 Start Point 

 End Point 

 Listening Level 

 Air Attenuation Compensation 

Select Anti Reverberation System checkbox to enable anti reverberation feature (see previous paragraph 

for a complete description). 

The Column Height is defined as the height in meters between below floor and line array bottom side. 

Instead of defining beam shape by angles, user can select a range along SPL variation does not exceed 

more than 3 dB.  

User can define such range selection by means of Start Point and End point text boxes, by typing values in 

meters.  

 

Line Array Height 

Start Point Listening Level End Point 



AVE Line Array User Control – Software Manual 
  

 

A.V.E. mbH - Germany  Document Version 1.0.2 – April 2014 

Page 15 
 

  

Figures: SPL Field examples for distances setting mode for different ranges. 

Listening Level represents the average height of the audience plane and it would be a point midway 

between the sitting and the standing position (normally 1.2 m – 1.3 m). 

 

Figure: Listening Level. 

With Air Attenuation Compensation enabling check box, users may specify a frequency response 

correction in SPL analysis, based on a given relative humidity and temperature.  

Remember that air absorption is sensitive to air temperature, air composition, particularly humidity 

concentration, and sound frequency. 

It is particularly necessary to account for air absorption in large spaces. 

 

Figure: Air Attenuation Compensation. 
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3.5 - Computing Beam Configuration 

Pressing Calculate Beam button, the AVE Line Array User Control software computes spatial filtering 

analysis on each audio output channel to fit your input beam requirements.  

Optimum spatial filtering DSP processing allows user to obtain the desired listening pattern making line array 

unit high directive, featuring the beam less dependent on the frequency and minimizing side-lobes energy. 

Once the analysis is completed, the predicted audio beam is then depicted both on SPL Field and SPL Field 

along Listening Level plots. 

 

Figure: Analysis Beam. 

Selecting the Set Beam button would cause the application to send spatial filter coefficients to AVE line 

array unit and stored in non volatile memory in the unit themselves. 

 

Figure: Set Beam. 

Note: make sure you have a RS-485 network connection with AVE Line Array when using Set Beam button. 

Note: using Set Beam command, it will overwrite existing beam setup stored inside line array unit. 

Both beam configuration and audio settings, stored inside the line array unit, can be retrieved whenever 

needed using Get Configuration in Tools menu (see Menu chapter). 
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4.0 – Audio Control 

The Audio Control panel features advanced digital signal processing to configure the main audio parameters. 

AVE mbH has designed exclusive DSP functions that greatly enhance the capabilities and performance of 

the AVE Digital Line Array. These functions include equalizer, time alignment and presets control. Simply 

click and drag any marker in the graph for easy control of Frequency, Gain and Bandwidth of filtering 

modules.  

 

 

 

 

Figure: Audio Control Panel. 

4.1 – Main Audio Panel 

Key features in the Main Audio panel are: 

Input Channel Control: to choose which input to switch to the output: Line Input Level (0 dBu) or 100 V 

Input Level. 

Input Phase Control: to reverse the phase of the signal when multiple microphone applications pick up the 

same signal from different locations (in some such cases signals can be out of phase and sound and audio 

is “thin” or “out of position”). 

Delay Control: designed primarily for time alignment in multi-speaker sound systems. With 50 m equivalent 

maximum time delay (ca. 150 ms), the AVE Digitally Controlled Line Array can be aligned with multiple 

Equalizer Plot Main Audio Panel Solo Panel 

Filter Draggable Handles 

Equalizer Panel 
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speaker systems from small room acoustic to the largest environments such as churches, cathedrals, 

venues, etc. The minimum delay increment of 0.1 m (ca. 294 µs) allows fine speaker alignments. 

Volume Control:  used to match the input sensitivity of the line array to the particular source unit that you 

are using. The volume control can be programmed from a gain of +6 dB to an attenuation of -120 dB in 0.5 

dB step. 

Mute Control: to remove temporarily the output from the line array unit. 

Solo Control: to isolate a particular loudspeaker channel so that only that channel's output is heard. 

 

Figure: Main Audio and Solo Panels. 

Equalizer Preset Selection: to quickly access three default preset equalizations: 

 Flat with no filtering modules 

Equalizer Preset neither emphasizes nor de-

emphasizes any part of the audio spectrum. 

  

Figure: Flat Equalizer 

 Speech  

Equalizer Preset with two fixed filter 

intended to exalt voiced sounds. 

 

Filter #1: lowshelving   f = 4000 Hz, G = -12 dB, Slope = 6 dB/oct 

Filter #2: highshelving  f =   250 Hz, G = -12 dB, Slope = 6 dB/oct  

Figure: Speech Equalizer 

Input Channel Selection 

Input Phase Selection 

Delay Control 

Volume Control 

(slider) 

Volume Control 

Mute Control 

Equalizer Preset Selection 

Solo Control 

Configure Line Array 

Equalizer 
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 Music  

Equalizer Preset with two fixed filter suitable 

to exalt music sounds. 

 

Filter #1: lowshelving  f =   250 Hz, G = -12 dB, Slope = 6 dB/oct 

Filter #2: highshelving f = 4000 Hz, G = -12 dB, Slope = 6 dB/oct 
 

Figure: Music Equalizer 

 Or to assign three different custom preset equalization, fully configurable:  

 Custom #1 

 Custom #2  

 Custom #3  

which can be recalled quickly with AVE Infrared Remote Control. 

4.2 – Equalizer Panel 

High Precision 8-Modules Equalizer: once your beam design is completed, you can design a suitable 

audio equalization to be applied to increase the naturalness or intelligibility of the voice or to compensate 

environment acoustic. 

AVE mbH have developed an optimized technique of IIR filter design and realization to minimize the effects 

of round-off noise at the filter output.  

All filter modules are based on ultra low-noise and low-distortion algorithms.  A new structure for IIR filters is 

adopted, which exhibits reduced coefficient sensitivity and superior round-off noise properties as compared 

to the classic filtering realization. 

 

 

 

 

 

 

Figure: High Precision 8-Modules Equalizer. 

Magnitude Tab 

Phase Tab 

Group Delay Tab 

Flat Button Equalizer Gain 

Filter Selection 

Filter Parameters 
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High Precision 8-Modules Equalizer allows user to configure easily up to 8 filtering modules selecting 

among following filter typologies: 

 Master Gain  

Control to adjust general level over a range from -24 dB to 

24 dB in arbitrary steps. 

 

Clicking the Flat button forces all the EQ modules to bypass 

but it does not clear typed filter parameters. User can recall 

them simply reverting filter type from Bypass to previous 

one.  

 

 Bypass 

Allows all audio frequencies to pass.  

It does not affect magnitude and phase of the input 

signal.  

 

 Butterworth High/Low Pass Filter 

The Butterworth filter is a type of signal processing filter 

designed to have frequency response as flat as possible 

(no ripples) in the pass-band and zero roll off response 

in the stop-band.  

This type of filter allows only frequencies above/below 

the cut-off frequency to pass thus eliminating low/high 

frequencies respectively.  

For example, a high pass filter is extremely useful for 

eliminating booming sounds inside churches with high 

reverberation time. 

 

 

 

Figure: Butterworth Highpass Filter 

 

Figure: Butterworth Lowpass Filter 

 

 

Flat filters 

Master Gain 

Bypass Selection 
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Butterworth High/Low Pass filters are characterized 

by two control only:  

 Cut-off Frequency (from 20 Hz to 20 kHz). 

 

 Roll-off slope (-12 dB/oct or -24 dB/oct). 

 

You change Cut-off frequency by dragging leftward or 

rightward the red squared handle. 

 

 

 High/Low Shelving Filter 

 

It allows reducing or boosting all frequencies equally, 

above or below a desired cut-off frequency, and making 

a straightforward and efficient implement for bass and 

treble control.  

 

User can select a high/low shelving filter to reduce the 

high/low frequencies respectively without completely 

eliminating some frequencies, as would happen with a 

classic high/low pass filters. 

 

It is useful for getting rid of low-frequency hum, mic 

bumps, and rumbles. 

 

High/low shelving filters have three controls: 

 

 Knee Frequency (from 20 Hz to 20 kHz), 

 

 Gain (from -24 dB to 24 dB) 

 

 Roll-off Slope (-6 dB/oct or -12 dB/oct). 

 

Figure: Lowshelving Filter 

 

Figure: Highshelving Filter 
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Filter Selection 

Cut-off Frequency 

Roll-off Slope 
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Filter Selection 

Knee Frequency 

Roll-off Slope 

Gain 



AVE Line Array User Control – Software Manual 
  

 

A.V.E. mbH - Germany  Document Version 1.0.2 – April 2014 

Page 22 
 

 PEQ Filter 

PEQ filters can be used to realize complex frequency 

curves with highest precision. It represents the most 

useful and versatile audio filter for a wide range of 

applications. For example, using the very narrow 

notching PEQ filters, it will eliminate most audio 

feedbacks in your audio system. 

The PEQ filter gives the user three controls parameters: 

 

 Central Frequency. 

 Bandwidth. 

 Notching/Peaking Gain. 

 

Central Frequency (from 20 Hz to 20 kHz) adjusts the 

center of the range of frequencies which will be boosted 

(increased) or cut (reduced). 

 

Bandwidth (in fractional octave) controls the range of 

frequencies that will be boosted or cut. 

 

Notching/Peaking Gain (from -24 dB to +24 dB) 

controls how much of the given range of frequencies 

should be added or removed. 

 

To adjust a parametric filter, insert values in textboxes 

or just point and click on the filter. Each red squared 

handle has two light blue squared boxes. Drag these to 

adjust the bandwidth of the filter. 

 

Figure: Peaking Filter 

 

 

Figure: Notch Filter 

 

 

 

  

PEQ Selection 
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4.3 – Equalizer Plot 

Once users have designed the filter, they can view the following filter analyses in the display window by 

clicking any of the buttons: Magnitude, Phase or Group Delay on the EQ tabs bar. 

 

 Magnitude response 

 

 

Figure: Magnitude  

 Phase response 

 

 

Figure: Phase  

 Group delay response 

 

 

 

Figure: Group delay  
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5.0 – Menu Commands 

5.1 – File Menu 

AVE Line Array User Control File menu contains various commands for opening, saving, 

exporting, printing and closing projects. 

5.1.1 – New Project 

To create a new Project in AVE Line Array User Control, follow these steps: 

 

Figure: New project. 

 

 

Figure: New Project dialog box. 

1. Click the New Project on the File menu, or press CTRL+N. The New Project dialog box appears. 

 

2. In the New Project dialog box select the proper line array series from leftmost column, and then 

choose the line array model in middle column which matches the used device. The rightmost 

column shows main features of the selected line array of loudspeakers. 

New Project 

Project Name 

Project Location 

Line Array Series 

Line Array Models 

Line Array Information 
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3. Name the project, select his location, and then click OK. By default, the AVE Line Array User 

Control application saves a project named untitled.prj in the default working folder. 

Keyboard Shortcut: Ctrl+N 

5.1.2 – Open Project 

If user needs to edit one project that exists already, choose Open in File Menu, or press CTRL+O, and then 

browse to find the file you want.  

Then double click on the file name to open it in main window. Loading a project returns the AVE Line Array 

User Control to the state it was in when the project was saved, and the working directory set to that of the 

loaded project. 

Keyboard Shortcut: Ctrl+O 

 

Figure: Open Project. 

 

 

Figure: Open Project dialog box. 

Project Name to Open 

Project Directory 

Open Project 
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5.1.3 – Save Project 

Use the Save command in File menu to save the currently active line array project to your file system. When 

user closes an unsaved document, or attempt to quit AVE Line Array User Control with unsaved open 

project, AVE Line Array User Control will prompt you to save your work before continuing. 

Keyboard Shortcut: Ctrl+S 

Save As command in File menu is same as Save above, but allows user to save a copy of an open project 

to a different name or location.  

This can be useful if you want to preserve a snapshot of the state of a project at a particular time, and then 

proceed to make further changes to the project you just saved. 

Keyboard Shortcut: Ctrl+Shift+S 

 

Figure: Save Project and Save Project As... 

 

 

Figure: Save As dialog box. 

Save Project As... Save Project 

Project Directory 

Project Name to Save As 



AVE Line Array User Control – Software Manual 
  

 

A.V.E. mbH - Germany  Document Version 1.0.2 – April 2014 

Page 27 
 

If you specify a filename that already exists, a warning message is displayed. Select Yes to use the filename 

or No to return to the dialog to select another filename. If you select Yes, target file will be overwritten. 

Note: after you modify a project in the panels, an asterisk (*) follows the file name. This asterisk indicates 

that there are unsaved changes to the file. 

5.1.4 – Close Project 

Choose Close Project menu item to close the active project. If you’re closing a document to which you’ve 

made changes not yet saved, AVE Line Array User Control will ask you if you want to save your changes. 

 

Figure: Close project dialog box. 

Click Yes to save your changes, or click No if you don’t want your changes preserved. Click Cancel to return 

to that project without closing it. 

Keyboard Shortcut: Ctrl+W 

5.1.5 – Export... 

SPL Field as well as Equalization plot may also be exported as image, choosing among different formats 

(BMP, GIFF, JPG, PNG and TIFF), for use in documentation and proposals. 

1. Click the Export... on the File menu then choose one of Beam Plot or Equalizer Plot menu items. 

 

2. In the Export dialog box choose the output directory and then the filename and the proper image 

format too. 

 

Figure: Export Beam Plot. 

Export... → Beam Plot 
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Figure: Export Equalizer Plot. 

 

 

 

Figure: Export dialog box. 

 

Figure: Exported SPL Field image. 

Image Name to Export 

Output Directory 

Supported Image Formats 

Export... >Equalizer Plot 
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5.1.6 - Print 

The Print menu item opens the standard Print dialog box. This dialog box enables you to generate a report 

to the currently selected printer of all parameters contained in a Beam Design panel, including SPL Field 

plot. 

Keyboard Shortcut: Ctrl+P 

 

Figure: Print... 

 

Figure: Exported Equalizer Plot. 

 

Figure: Print dialog box. 

Print Selection 

Print 
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5.1.7 - Exit 

Close current project window and exits AVE Line Array User Control. If there are any unsaved changes to 

your project, AVE Line Array User Control will ask if you want to save them. 

Keyboard Shortcut: Alt+F4 

 

Figure: Exit. 

 

Figure: Printed Report. 

Exit 
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5.2 –Setup Menu 

The setup menu allows you to customize the operation of the Line Array User Control. 

5.2.1 – COM 

User can select the serial port COM number from the COM menu item in Setup menu, which will be used by 

USB-RS485 serial converter to communicate with the AVE Line Array unit. 

 

Figure: COM. 

 

Figure: COM Setup. 

The proper COM port number associated to the USB-RS485 Serial Converter can be retrieved in Windows 

opening Device Manager and checking Ports (COM & LPT) or you can disconnect your USB-RS485 

converter and re-open the menu SETUP→COM menu; the entry that disappears should be USB-RS485 

converter. Reconnect USB-RS485 Serial Converter and select that serial port. 

 

Figure: Control Panel. 

COM 

COM Port Speed 

(fixed) COM Port Number 

System and Security 
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Figure: Control Panel – System and Security. 

 

Figure: Control Panel – System and Security - System. 

 

Figure: Device Manager. 

System 

Device Manager 

USB Serial Port 
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5.3 – Tools Menu 
 

This menu contains various tools for working with current project. 

5.3.1 – Analyze Beam 

Pressing Analyze Beam command, AVE Line Array User Control software computes the best beam setup to 

fit your input beam requirements and then it plots predicted SPL field and SPL Field along Listening Level. 

This command invokes the same beam analysis function as Calculate button in Beam #1 Parameters tab. 

Keyboard Shortcut: F5 

 

Figure: Analyze Beam. 

5.3.2 – Set Beam 

Pressing Set Beam menu item, AVE Line Array User Control software sends computed beam setup to line 

array unit. AVE Line Array User Control will ask you if you want to download your beam configuration. Click 

Ok to send your beam setup, or click Cancel if you want delete command and return to project window.  

Note: make sure you have a RS-485 network cable connected to the line array unit when using Set Beam 

menu item. 

Note: using Set Beam command, it will overwrite existing beam setup stored inside line array unit. 

Keyboard Shortcut: F7 

 

Figure: Set Beam. 

Analyze Beam 

Set Beam 
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Figure: Set Beam dialog box. 

5.3.3 – Set Configuration 

User can send the current line array configuration, comprising both beam and audio designs, by selecting 

Set Configuration on the Tools menu.  

This function is useful to configure quickly a pair of line array units. 

 

Figure: Set Configuration. 

A dialog box asks user to approve requested operation. 

Click Ok to send the entire line array configuration, or click Cancel if you want delete command and return to 

project window. 

 

Figure: Set Configuration dialog box. 

5.3.4 – Get Configuration 

At meantime, AVE Line Array User Control allows retrieving set-up configuration stored inside a line array 

unit by mean the Get Configuration function on Tools menu.  

Set Configuration 
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Figure: Get Configuration. 

Click Ok to get the entire line array configuration, or click Cancel if you want delete command and return to 

project window. 

 

Figure: Get Configuration dialog box. 

On retrieving completion, Beam Design and Audio Control panels are populated with loaded parameters 

and SPL Field and SPL Field along Listening Level are plotted. 

5.3.5 – Reset Configuration 

The command Reset Configuration in Tools menu clears all configuration of the line array unit and sets it 

to the default, including beam and main audio parameters as well as custom equalizations. 

 

Figure: Reset Configuration. 

A dialog box asks user to approve requested operation. 

Click Ok to reset the entire line array configuration, or click Cancel if you want delete command and return to 

project window. 

Get Configuration 

Reset Configuration 
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Figure: Reset Configuration dialog box. 

PLEASE NOTE: all of your data settings will be erased using the Reset Configuration command. 

5.4 – Windows Menu 
 

The Windows menu allows user to switch panels between Beam Design and Audio Control. 

 

Figure: Windows menu. 

 
5.5 – Help Menu 
 
The help menu enables user to collect information related to the line array unit such as installed hardware 

and firmware versions, as well as to get information and to check for updates about current AVE Line Array 

User Control application. 

5.5.1 – Line Array Info 

By Line Array Info menu item, user can retrieve the product name, the device and hardware IDs and 

firmware version of connected device. 

 

Figure: Line Array Info. 

5.5.2 – Check for Updates 

By default, AVE Line Array User Control is set to automatically update itself but user can always do a manual 

update. The Check for Updates menu item checks to see if you have the most current version of AVE Line 

Array User Control.  

Line Array Info 
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Figure: Check for Updates. 

You will be prompted to download the latest version if your version is out-of-date. Clicking Install update in 

Software update dialog box, AVE Line Array User Control will begin downloading updates automatically. 

Note: an Internet connection is required to use this feature.  

 

Figure: Software Update. 

5.5.3 – About AVE Line Array User Control 

The About AVE Line Array User Control menu item activates the About AVE dialog box.  

This dialog box provides information about installed application version. 

 

Figure: About AVE Line Array User Control. 

 

Check for Updates 

About AVE Line Array User Control 

Install update 
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Figure: About AVE Line Array User Control message box. 
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6.0 – System Requirements 

 

Recommended System Requirements 

 Windows 7 (32-bit or 64-bit). 

 Intel® Core™2 Duo/Quad 2.66GHz (or faster) processor or equivalent. 

 4 GByte RAM. 

 500 MByte hard disk space. 

 Main monitor 1280x1024 screen resolution. 

 NVIDIA® GeForce® 8000 series, 256MB (or more) graphics card or equivalent. 

 USB2.0 port. 

 CD/DVD Drive. 

 Adobe® Reader® 8 (or above). 

 

Minimum System Requirements 

 Windows XP Professional SP2 (or later). 

 Intel® Pentium™ 1.8GHz processor or equivalent. 

 2 GByte RAM. 

 100 MByte hard disk space. 

 Main monitor 1280x1024 screen resolution. 

 NVIDIA® GeForce® 6000/7000 series, 128MB graphics card or equivalent. 

 USB2.0 port. 

 CD/DVD Drive. 

 Adobe® Reader® 8 (or above). 
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Notice 

ALL AVE mbH DESIGN SPECIFICATIONS, FILES, DRAWINGS, TABLES, LISTS, AND OTHER 

DOCUMENTS ARE BEING PROVIDED “AS IS.” 

AVE mbH MAKES NO WARRANTIES, EXPRESSED, IMPLIED, STATUTORY, OR OTHERWISE 

WITH RESPECT TO THE MATERIALS, AND EXPRESSLY DISCLAIMS ALL IMPLIED 

WARRANTIES OF NONINFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A 

PARTICULAR PURPOSE. 

Information furnished is believed to be accurate and reliable. However, AVE mbH assumes no 

responsibility for the consequences of use of such information or for any infringement of patents or 

other rights of third parties that may result from its use. No license is granted by implication or 

otherwise under any patent or patent rights of AVE mbH. Specifications mentioned in this 

publication are subject to change without notice. This publication supersedes and replaces all 

information previously supplied. AVE mbH products are not authorized for use as critical 

components in life support devices or systems without express written approval of AVE mbH 

Corporation. 

Trademarks 

AVE mbH and the AVE logo are trademarks or registered trademarks of AVE mbH in the Germany 

and other countries. Other company and product names may be trademarks of the respective 

companies with which they are associated.  

Copyright 

© 2014 AVE mbH. All rights reserved. 
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